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Vectric VCarve

This page is all about up-skilling you in VCarve to make best use of the CNC Routers. You will learn:

¢ An overview of CNC Routing and pre-production

How to set-up and use your Vcarve Makerspace Client edition

Standard Vcarve settings used in the Fabrication Lab including The Edge CNC
tool database

Basic vector optimising techniques
How to troubleshoot vector issues
 Toolpath basics, tips and tricks

The Edge Fabrication Lab has a VCarve Pro Makerspace license.

This allows unlimited users to download a trial version of the VCarve Pro Software which is completely
functioning except for the final stage of exporting of an Numerical Code (NC) file for a CNC router to
cut, or other vector formats.

Vcarve is Windows only software - if you require access to a Windows machine you can use the
Fabrication Lab computers for free, booking required.

The License key for this offer is 86B4F-F467A-280D9-9F4C6-9C56B-4C528-BEEGF - you need to enter
this in your version of Vcarve Pro.

You can design, layout and program tool-paths on your own machine at home save the file as a
VCarve File, bring your file on a USB to your CNC booking.

The advantage to this is also that The FL supervisor has an opportunity to check the setting of a job
before allowing it to be cut on our machine.

Again - The cut files can only be cut on The Edge's Makerspace licensed machines.

CNC Router Basics

A basic CNC Router is a simple machine, with a rotary tool (bit) moving along a path controlled
numerically by a computer - ie. Computer Numerical Control (CNC). The diameter and cutting depth of
the tool are key considerations when designing for routers.

To cut files on a CNC Router, we need to describe a path for our router move on. The most efficient
way to do this is to use vector graphics. 2D points can be joined to create lines, curves, form polygons
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and other shapes to describe our path, which can then be converted to Numerical Code (NC), simple
co-ordinates our machine understands *.

VCarve Workflow Pre-Production

A reqularly used workflow at The Edge is for users to create a design in a 2d vector drawing program
like Adobe lllustrator, Corel Draw or Inkscape and import the design into VCarve to program an
Numerical Control (NC) file for cutting on the Multicam CNC.

The basic steps are:

e Create a vector file

e Optimise/export your vector file
e Import into Vcarve

e Check/clean vectors

e Layout Shapes

e Create Toolpaths

e export to NC file

Creating a vector file is out of scope for this introduction - use these example files if needed or you
can create your own iconic fretwork.

¢ base.dxf
e side.dxf
o fret.dxf

Optimizing your Vector file

There is the long list of things you can do to when designing and prepping your vector file to ensure
that it is imported into Vcarve efficiently. While you can fix issues in Vcarve, its usually easier to do so
in the original format.

Ensure the following before export:

¢ All you shapes are closed/joined paths
e Any text is converted to curves and closed/joined paths
e Any parts with multiple paths are grouped together so they can be moved around without
disturbing their arrangement.
e There is not multiple copies of paths hiding behind your shapes/ parts.
e Your units are millimeters.
e Your design fits inside you material sheet size
 Your design is scaled properly
e Export your design in an appropriate format. We recommend using at least two formats:
o DXF (export as latest version available and R17)
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Using VCarve Makerspace Client Edition

It is imported to use The Edge makerspace ID - otherwise your designs will not open on the
Fabrication Lab machines! To do this open the about menu

About VCarve Pro Trial Edition >

VCarve Pro Trial Edition - 64 Bit £
Version: 9.512 (Build 4863,5254.8568)
Built: Mov 28 2018

Capyright (C) Vectric Limited 2005 - 2018
Licensed to:

VCarve Pro Trial Edition
Evaluation License - NOT FOR RESALE

Enter Makerspace ID

Vectric would like to thank the following people for their help
and input during the development of the program.

Mote; the kst is in @ random and different order every time ...

Bil Lebeda e
Martin Pearson

Gert Burkhardt 1
Gary Campbel |
Randall Mewcomb

Dion Kerschner v

[ ]

And enter The Edge Makerspace ID.
86B4F-F467A-280D9-9F4C6-9C56B-4C528-BEE6GF

You will then have to close and relaunch VCarve.

Create a new Vcarve File

1. Click the new file icon or select the New option from the File menu
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File Gadgets Help

VCaryeY

MAKERSPACE CLIENT EDITION

Startup Tasks

L

; Open an PJew - create a new empty file i
Recently opened files ...

Video Tutorials
n Tutorial Video Browser...

Purchase VCarve Pro
a Purchase VCarve Pro Now!

Online Resources
Vectric Web Site
n Support Web Site
a Vectric Forum

ﬂ Vectric on Facebook
ﬂ Vectric on Twitter

Clipart & Projects
@ Design & Make

Vectric VCarve

2. Choose Either a Single Sided Job or Double Sided Job in the Job Type (double sided jobs are ones
that you need to turn the material over to make cuts on the other side)

QThe Edge

2025/07/04 05:00

Vectric VCarve




SLQ Wiki 6/32 Vectric VCarve

%" JobSetup

Job Type
{4
o

Job Size

Single Sided
ouble Sided
() Rotary

Width (X):
F

Height (Y):
%7 Thickness (2): 15.0

Units (inches @ mm

E

E

5

Z Zero Position
() Material Surface
(®) Machine Bed

XY Datum Position
OO [ Juse Offset

O

¥:1 0.0

| Modeling Resolution

Bl standard (fastest) v
1 million points
Appearance
@,/  Solid Color v
Solid Color: | [N ¥
oK Cancel

3.The standard Job Sizes are 1200 Width(X) 1200 Height(Y) Thick 15 (Z).Ensuring you are using the
mm option as your unit of measure.
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@ JobSetup

JbTYPE G Singe Sided

Job Size
width 00: 1200 | mm
z
ﬁ Height (Y):| 1200 mm
%7 Thickness (2):| 15| mm
Units () inches @) mm
- -
I Zero Position /‘ﬁ
(®) Material Surface
. (C) Machine Bed
XY Datum Position

OO [[Juse Offset

-

¥: 0.0
| Modeling Resolution
B standard (festest) .
1 million points
Appearance
¢,/ Sold Color v

Solid Color: [N ~
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" JobSetup

Job Type @) Single Sided

Width (X):| 1200 mm
Height (Y):| 1200 mm
X7 Thickness (2):| 15 mm

Units inches @ mm

Z Zero Position

() Material Surface
. %&d‘ine Bed

X¥ Datum Position
OO [Use Offset

ol SR

Modeling Resolution
Bl standard (fastest) v
1 million points
Appearance
%5/ Solid Color v
Solid Color: | I v
OK Cancel

5. Leave the XY Datum Position as the Default. Home is in the bottom left hand corner.
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¢ JobSetup

JobTyPe G single Sided
1. (C) Double Sided
O Rotary

Job Size

Width (x):| 1200 mm
Height (Y):| 1200 mim

=57 Thickness (2):] 15 mm

z

Units (inches @®mm

Z Zero Position
() Material Surface
(®) Machine Bed

XY Datum Position
OO [[JUse Offset

O

' Modeling Resolution )
‘Standard (fastest) v
1 million points
Appearance
'i-:j/ _Sﬁd Color "
Solid Color: | NN ¥

oK Cancel

6. When you are happy with all these settings click Ok.
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¥ JobSetup

JobTYPE G single Sided

3

3

3

Z Zero Position
(C) Material Surface
(®) Machine Bed

Modeling Resolution

‘ Standard (fastest) v
1 million points

Appearance

i_'yl Solid Color v

Solid Color: | NN ¥

Cancel

Ok
e

VCarve will then display a 2D workplane, with our vector tools off to the left.
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You can always double check these settings in the Edit menu under Job Size and Position
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Edit | Model Toolpaths View
A Undc Ctrl+Z o
| Redc trl+
&b Cu rl+
L Co Ctrl+C
W 2 Paste _trl+
g Delete Ctrl+De
b Selection b
Align Selected Objects  »
i Join Vectors J
Curve Fit Vectors
" Mest Selected Objects

Job Size anquusitinn

Rendicitim——:

Document Variables

-

Snap Options F4

Options
N~ N A

Importing Vectors

Import your vector File by selecting the Import Vector icon in the File Operations Toolbar or select
Import Vectors from the File Menu. If you don't have a vector handy - try this

fretwork DXF
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¥ Viare Fro MIFIFSPEEE Lhent 9.312 - | Mew|

File | Edit Model Toolpaths View Gadgets Help

O New CirlsN
@ Open.. Ctrl+ O
Close

EH save Ctrl+5
Save As...
Increment and 5ave  Ctri+Alt+5
Pnnt...
Print Preview
Print Setup...

2D View ' 3D View & Layer 1~

N T Y

=
=

| Import...

']

Export...
Open Application Data Folder...

Recent File
Ext

ra

Impert Vectors... Ctri+l

Import EltrL@l

Import Cormponent / 3D Model...
Import PhotoVCarve, Machinist or Cut3d Toolpaths...

* Eait Ubjects
R Qe Ry 20 2% &
& @ e W@f

Vcarve will import your vector to the bottom left corner of the Design Window ( zoom out if you can't

see it)
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Check/Clean Vectors

Now ensure that all the paths that make up the shapes of your job are closed/ joined. Select the Join
icon from the Edit Tools Toolbar and select all the paths you want in a shape.

File Operations

Transform Objects

—
B Do L Z0 Ox
IR/ £

You may need to adjust the tolerance of the Join tool to ensure Vcarve can fill in the gaps between the
multiple paths.
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) Join Vectors

i 5
Cperc ]
i Tokeramoe:
0.0l |
)} Vectors after joining:
Oosedt 6
Cpere a

R

Vectric VCarve

e o s

L

Next lets check our curves, this is important to ensure smooth cutting. Switch to Node Edit Mode
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File Edit Model Toolpaths View Gadget
Drawing Bl 2

S
D |
HddBRoo
Create Vectors
e

Transform Objects
AR HDTE e

Bwogecs
| e B8 9% 42

o 7 o

Mode Editing Mo

de

by 9 oF B8 &

Then select one of your vectors. You will see either a nice smooth geometric lines (a line, arc or
bezier)

T~

Or an ugly collection of polylines
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- ™~

A

Zoom in and you will see the small line segements - these are to be avoided with CNC Routing

To fix this we will use the Curve Fit tool.
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File Operations
N e
Hi4 BB
Create Vectors
Cedo*
2™ SR
T T b TF see
v
Transform Objects
ot S I P w
Edit Objects
b Do N 28 2% 4o
&GC &
C VMO @ =
'E:} j ) Curve Fit - fit curves to selec

Offset and Layout

O B & oF B8 2

The aim here is to reduce the number of points, while still keeping the shapes you want. I've gone
with circular arcs, and a tolerance of .5 mm
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f Fit Curves to Vectors

Fitting Type ...
(®) Circular Arcs

O Bezier Curves

() Straight

Tolerance:

Lines

0.5

mm

Keep sharp corners

Max. Angle |©60.0
Replace selected vectors

dearees

Preview

Cancel
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Into this

Not this (too large tolerance)
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A
Tool fit and Assembly

For this example job we are using an 6.25mm tool, so lets take a moment to measure our designs
tight sections to make sure the tool will fit. otherwise we may produce a piece that looks like this.

Instead of:

Q The Edge 2025/07/04 05:00 Vectric VCarve




SLQ Wiki 22/32 Vectric VCarve

This process will likely be repeated when we make toolpaths later on.

We will use the measuring tool.

O e
[ w @@= [
s BB ]
Create Vectors

Cedo % I
2SS ® |
T 1 e T s

-

Transform Objects 7
el S B i P e

Edit Objects
bl Ry 29 2% I
{:\_.I = 71 ﬂ Measure-ri'leasure distance, a'ea_lenqthet-:.h
CVvrodo
(I BT

Offset and Layout .

(=T
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Clicking on one edge, then the next, this section of the Fretwork is about 4.5mm wide. Too narrow for
our (6.25mm) tool.

Node Editing

Lets widen that gap using our node edit mode. Click on our curve to select it.

S

Then drag and grab the points you want (they will go red) , then move them with the mouse - our
nudge with the arrow keys.
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S

Dogbones

In order for our design to fit together straight of the machine - you may need to use dogbone fillets.
This is a small arc on inside corners that fits the tool, and ensure a joint fits to its full length.

For our fretwork example to fit into a base, both the fretwork and base will need to be filleted.
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Use the fillet tool from the Edit Objects menu
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Drawing Bl
File Operations
G
Create Vectors

Celdo %

2™\ S

-----

T T L T se

Eili}»h-:-”@”g{”‘z

= IR ]

HYV LSS H =

'd Fillet - create fillets between spans i

Offset and Layout

ins 9 o0 BE &

Vectric VCarve

And set the fillet/tool radius to 1/2 your tool diameter, selecting dogbone as the fillet type.
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C  Create Fillets

mm

Fillet ;trml Radius:

Click on an angled corner to change

corner into a circular filet

Fillet Type

T | Onormalfillet

‘Dog-Bone’ Fillet

These fillets are used for
l__ _l creating dearance in internal

corners to allow slotted

pieces to fit together.

() 'T-Bone" Fillet

These fillets are used for

! ! creating clearance in
internal corners when the
slot is the same size as the

tool

() 'Plasma/Drag Knife' Fillet

These external filets are
used for machining past a
corner when using plasma

tools or drag knives

Removing Fillets

To remove a fillet, dick on the fillet arc.

Close
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Then hover over an internal corner (you may have to ungroup your shapes first) until the cursor turns
into a tick.

I
v

Click to produce a dogbone. If you can't add one - you may need to join your shapes.
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-

Layout

Its time to move and arrange our design on the material - the first step is to group all the shapes so
we don't lose our design. Use ctrl-a or drag and select everything, the use Ctrl-g to group (or the
group menu button).
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File Operations
D) = e G =
A BB
Create Vectors
Cedok i
NS .
T T B T s -
v :

Transform Objects 8-
HEBA B D ¢ )
Edit Objects -

b Bo b [F)2% o _

% @ o | Group - group selected crbjectsJ

=T

VIR D ]
@23 > 2 -

Olfsetandlayurl -

0 B o oF BB # -

1

Group and Move

In the 2D View tab, select the Transform Mode selection tool form the Edit Objects Toolbar and drag
the shapes into place on the rendering of your material. Or slow click on your shapes.

3. Once you are happy with the placement of the individual parts on the material, ensure that you do
not have hidden / multiple copies of the paths that make up the shapes. Search for these extraneous
paths by dragging or deleting ungrouped paths and undoing the operation when you have established
you only have the paths required.
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Setting up Toolpaths

Toolpaths are the path or route the CNC Router will move the spindle on. The path always follows a
vector from your file.

The CNC Router requires more information about the type of tool you are using and how you want to
cut/remove material. this is defined in the toolpath menus - found in the top right.

Toolpaths ;
2
b=

Material Setup XYDi Auto Hide
j 5.0mm

Set... zu.:[ 15,0mm

X: 0.0
Home Pos: X:0.0Y:0.0 Z:20.0 ¥: 0.0
Toolpath Operations
QO&HTY
&Gy E Y

*
& @
E

[] Toolpaths 1L

The Edge Vcarve Tool Database

Please use the latest version of The Edge Vcarve

tool library
. Download, unzip, then merge this into your version of Vcarve
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Would you like to merge the databases or import it under the selected tool?

("res' to merge, ‘No’ to import)

Yes k_l Mo Cancel

1. Select a shape you want to apply a toolpath to.
2. Pin open the Toolpath Toolbars
3. Check the values in the Material Settings

4. Select one of the 12 types of Tool Operation you would like to apply to the toolpath - in this case

Remember to select the Tool operation order to optimize cut
accuracy and minimize the effects of vacuum bed dropoff as
parts toolpaths remove material. As a general rule use the
following order:

1. Drill and engraves and surface level pockets first

2. Then cut through pockets, internal cut paths and large
parts

3. cut external paths small parts last.

Offset and Layout your cutting job

Once you are satisfied that all the required Paths are closed shapes you can layout the multiples parts
required to be cut (Eg a 4 legs per stool and 6 stools are to be cut)

Using Vcarve @ The Edge

Vcarve Pro Makerspace edition is installed on the CNC Router PC in the Fabrication Lab and the laptop
attached to the Xcarve. These instructions are based on cutting a standard job, one-sided with the
stocked 15mm ply.

1)

3D shapes are beyond the scope of basic CNC Router use in the Fabrication Lab

QThe Edge 2025/07/04 05:00 Vectric VCarve




	Vectric VCarve
	CNC Router Basics
	VCarve Workflow Pre-Production
	Optimizing your Vector file

	Using VCarve Makerspace Client Edition
	Create a new Vcarve File
	Importing Vectors

	Check/Clean Vectors
	Tool fit and Assembly
	Node Editing
	Dogbones

	Layout
	Group and Move
	Setting up Toolpaths
	The Edge Vcarve Tool Database
	Offset and Layout your cutting job


	Using Vcarve @ The Edge


